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Uputstvo za podesSavanje mail klijenta

1. Podesavanje Thunderbird mail klijenta

1.1Dodavanje mail naloga

Da biste podesili Vas mail klijent (u ovom slu€aju Thunderbird) da prima i $alje mail-ove

potrebno je da uradite sledece:
- Pokrenite Vas Thunderbird
Kliknite na Tools -> Account Settings i trebalo bi da vam se otvori prozor kao na slici 1

- [o]x

& Mozilla Thunderbird .
File Edit Wew Go Message Account Settings
& . | autgoing Server (SMTP) Settings | O, Subject or Sender |
el e S ACH e beck | Although you can specify more than one oukgaing server (SMTF), this is only
2l Folders aour recommended For advanced users, Setting up mulbiple SMTP servers can cause
errars when sending messages.
Add...
R
Description:
Server Name:
Fort:
User Mame:
Secure Connection:
[ Add Account... ]
Re
| Done

Slika 1 - Prozor za dodavanje/podesavanje mail naloga

Nakon sto Vam se otvorio prozor kao na prethodnoj slici potrebno je da kliknete na dugme Add
Account Cime cete startovati Wizard (Carobnjak) za dodavanje mail naloga (slika 2).



= Mozilla Thunderbird

File Edit Wiew Go Message 1o

& 7 j | Oukgoing Server (SMTP)

= . Outgoeing Server (SMTP) Settings B Bibimh o Eerder: | |

et Mail Write  Address Book |

Account Wizard

4l Folders o |
New Account Setup

In order to receive messages, you first need to set up a Mail or
Mewsgroup account,

This Wizard will collect the information necessary ko set up a Mail or

Mewsgroup account, IF vou do not know the information requested,
please contact your System Administrator or Inkernet Service Provider.

Select the type of account you would like to set up:

O Gmail

D Mewsgroup account

4 | Done

Slika 2 — Wizard (¢arobnjak) za dodavanje mail naloga

Klikom na dugme Next dobi¢ete prozor kao na slici 3. u kome je potrebno da unesete Vase ime i
prezime ili naziv organizacije/firme ukoliko se radi o pravnom licu i Vasu mail adresu koju ste
dobili prilikom povezivanja na internet.

&, - / | QUao] Soer(EHITEN Qutgoing Server {SMTP) Settings | ssuiernmanies
GetMall ke Address Book — e
1] Account Wizard L3 = oty | e
All Folders o | Can Cause

Identity

Add...
Each account has an identity, which is the information that identifies Edit
wou ko others when they receive your messages. i

Enter the name you would like to appear in the "From” field of your
autgoing messages (For example, "John Smith").

Your Mame: | 1me i Prezime

Enter your emall address. This is the address athers wil use to send
&mail to you (for example, "user@example.net”),

Email Address! | vasamalladresa@zona,bal

[ <ok | [[mest> | [ concel |

v Done

Slika 3 — Unos imena i mail adrese prilikom podesavanja mail naloga

Nakon &to ste uneli trazene podatke kliknite na dugme Next i dobicete prozor kao na slici 4. gde
je potrebno da definiSete tip/protokol dolaznog servera (POP3 ili IMAP), adresu dolaznog
servera i adresu odlaznog servera. Osnovna razlika izmedu POP3 i IMAP protokola je ta Sto se
prilikom koristenja POP3 protokola Vase poruke skidaju na Va$ raCunar pre nego je moguc
pregled (moguce je takode u opcijama podesiti da se pored skidanja na racunar kopije poruka
sacuvaju i na mail serveru) dok se prilikom koridtenja IMAP protokola poruke isklju¢ivo Cuvaju na
mail serveru. U ovom slu€aju bi¢e objasnjeno podesavanje POP3 protokola.



Account Settings

4 Y, Oukgaing Server (SMTP)

=

autgoing Server (SMTP) Settings | T ET— |

Get Mail Write  Address Book

Account Wizard

All Folders L
Server Information

Select the type of incoming server you are using.

@ pop O IMAP

Enter the name of your incoming server (For example,
"mail example.net"),

Incoming Server: |pop3.zona.ba

Uncheck this checkbox ko store mail For this account in its own
directory. That will make this account appear as a top-level account,
Otherwise, it will be part of the Lacal Folders Global Inbox account.

Use Global Inbox {store mail in Local Falders)

Enter the name of your outgoing server (SMTP) (Far example,
"smtp.example.net"y,

Quktgoing Setver: |smtp.zona.ba

[ < Back ] L Mewt > ] [ Cancel ]

W' Done

Slika 4 — Definisanje protokola i podesavanje adrese dolaznog i odlaznog servera

Popunite polja kao $to su popunjena na slici 4. i kliknite na dugme Next nakon ¢ega ¢e Vam se
pojaviti prozor kao na slici 5. Za incoming i outgoing username Kkoristite prvi dio mail adrese
vasamailadresa@zona.ba (nije greSka ako unesete i ¢itavu mail adresu) .

= _Mozilla Thunderhird

Fle Edt View Go Dlessage Temiiilcd i
+* (Qukgoing Server (SMTF) i - i : =
& - Outgoing Server (SMTP) Settings 0. subject ar Sender
et Mail Write  Address Book y
Account Wizard
all Folders 1
User Names
Enter the incaming user name given ko you by your email provider {For
example, "jsmith"),
Incoming User Mame: ‘ wasamailadresa |
Enter the outgoing user name given to you by your email provider (this
ic bypically the same as your incoming user name), ——
Qutgoing User Mame: | vasamailadresa |
Ad
P [ < Back. ] L Mext = J [ Cancel ]
Remove Account
) Done

Slika 5 — Unos username-a koji ¢e se koristiti prilikom slanja i primanja poste

Nakon $to ste uneli trazene podatke kliknite na dugme Next i pojavice Vam se prozor kao na
slici 6.



= Mozilla Thunderbird

ISEES

File Edit Wew Go Message Account Settings
*. Outgaing Server (SMTRY = - ’ E _
o outgoing Server (SMTP) Settings |’(_,v Subjsct-or Serdér |
et Mail Write  Address Book 5
Account Wizard
All Folders o
Account Name
Add..
Enter the name by which wou would like to refer o this account (For Edit
example, "Work Account”, "Home Account” ar "News Account), et
Account Name: vasamaladresa@zona ba| |
= [ = Back ] L Mexk > ] [ Cancel ]
Remove £ 13
‘. Done

Slika 6 — Podesavanje mail naloga

Ovde nije potrebno da pravite bilo kakve izmene osim ako to Vi ne Zelite, tako da moZete ostaviti
ponudeni unos i kliknuti na dugme Next, a zatim na dugme Finish nakon Cega cete dobiti prozor
kao na slici 7. Ovim smo zavrSili prvi deo podeSavanja/dodavanja mail naloga Kkoristeci
Thunderbird mail klijent. U drugom delu obja$njeno je dodatno pode$avanje vezano za odlazni
server.



1.2 Dodatna podesavanja odlaznog servera (Autentikacija)

Gt Mail Write  Address Book
ol Folders

+ I Local Folders

B Account Settings

[=lLocal Folders
Disk Spare
Junk Settings

» | |2 vasamailadresa@zona.ba

Server Settings
Copies & Folders
Composition & Addressing
Disk Space
Junk Settings
Return Receipts
Security

Cutgaing Server (SMTR)

Outgoing Server (SMTP) Settings

#lthough you can specify more than one outgaing server (SHTP), this is only
recommended for advanced users, Setting up multiple SMTP servers can cause
errors when sending messages,

wasamailadresa - smtp zona.ba (Default)

fdd...

Description;
Server Name:

Fort:

User Name:

Secure Connection;

<not specified =
smtp.zona.ba

o
vasamailadresa
Mone

' Done

add Accourt...

i"-' Subject or Sender

Slika 7 — Podesavanje mail naloga

Nakon S§to smo zavrSili sa prvim delom dodavanja mail naloga dobi¢emo prozor kao na
prethodnoj slici. Da bi mogli da Saljete Vasu postu preko Zona mail servera potrebno je da se
izvrSe dodatna podeSavanja vezana za odlazni server. Da bismo ovo uradili kliknite na dugme
Edit (gore desno) i dobicete prozor kao na slici 8.

lhunderbird

file Edt View Gn  Message
& .

GetMal  Write  Address Book
Al Folders

# & Local Folders

=Local Folders
Disk Space
Jurk Settings

= vasamailadresa®zona.ba
Server Settings

Outgoing Server (SMTP) Settings

Akthough you can specify more than one outgoing server (SMTF), thisis only
recommendzd For advanced users, Setting up riultipls SMTP servers can cause
errars when sending messages.

Capies & Folders ; :
Composition & Adch SRS X
Diisk. 5
BT Sattings :
Junk Settings -
Return Raceipts Description: I|—‘
Security Server Name: | ‘

QOukgoing Server (SMTP 1
ging { Bart: 525 | pefau: 25

Security and Authentication

Use name and password

User Name: | wasamailadresa ‘

Use secure connection:
@0 O TS favalsble OIS O35

Add Account...

| Dane

[, uisct or Sendsr

Slika 8 — Dodatna podesavanja odlaznog servera

Ovde je potrebno da, ukoliko to ve¢ nije uradeno, Cekirate box Use name and password,
upiSete Va$ username (prvi deo mail adrese ili ¢itavu mail adresu) u polje User Name, zatim
izaberete opciju SSL u odeljku Use secure connection. Nakon §to ste to uradili kliknite na
dugme OK i vraticete se nazad na prozor Account Settings. Kliknite ponovo na dugme OK i
ovim ste zavrS$ili dodavanje/pode$avanje mail naloga.



2. Outlook Express mail klijent
2.1Dodavanje mail naloga

Pokrenite Va§ Outlook Express i kliknite na Tools->Accounts nakon ¢ega ¢e Vam se otvoriti
prozor kao na slici 9.

¥4 Inbox - Outlook Express

i File Edit WYiew Tools Message Help ,ﬂ.
7] J e - LR A

: |j‘| = aﬂ & “8 —= x = A% &I -

¢ Create Mail Reply. Reply All Farward Print: Delets SendfRecy Addresses Find

i [nternet Accounts
Falders X| H ceived

IS’] tlock Express Al |W|| Mews ||Erectory S;E| Add » |
B--@ Lacal Faolders
Account Type Connection L Femove J
@Active Directory directory service Local Area Metwork,
£ Sent Ttems @ Bigfoat Intemet ... directory service Local Avea Metwork igpeitcy
i Deleted Items (1} %Verisign Internet ... directory service Local Area Metwark Bl as Tiataul
5B Drafts @W’ho\:\u"here Inter...  directory service Local Area Metwark
Fro|
Sub
— Set Order...

There are no contacts ko display, Click
on Contacts to create a new contact,

0 messagels), 0 unread @ ‘Warking Online & Receiving mail. .,

Slika 9 — Podesavanje mail naloga u Outlook Express

Kliknite na Add->Mail i pokrenuc¢ete Wizard (Carobnjak) za dodavanje mail naloga (Slika 10).
Unesite VaSe Ime i prezime ili naziv Organizacije/Firme ukoliko se radi o pravnom licu i kliknite
na dugme Next.

s Inbox - Qutlook Express

i File  Edit  Yiew Tools Message  Help al'
g =] X :

. @ . & & 8 e X = W B .

¢ Create Mail Reply Reply all Forward Print Delete Sendffecy Addresses Find

Falders x [ Internet Connection Wizard
IS.F_! Outlook Express
=1 Local Folders Your Mame
L5 Inbox
- i Outhex
@ ERGILENS ‘when you send e-mail, your name will appear in the From field of the outgoing message.
{3 Deleted Items (1) Type pour name as you would like it to appear.
B Drafts
Display name: ||
— For example: John Smith
Fro
5ulb;
Contacts ¥ x

There are no contacts to display. Click
an Contacts bo create & new contact.

< Back Heut s

0 message(s), 0 unread E &9 Receiving mail...

Slika 10 — Wizard (Carobnjak) za dodavanje mail naloga




Otvorice Vam se prozor kao na slici 11. gde je potrebno uneti Vasu mail adresu koju ste dobili
od Zone prilikom priklju€enja na internet.

¥4 Inbox - Outlook Express

Fil=  Edit Wiew Tools Message Help

F . & & .8 2 X =3 W B

Create Mail Reply Reply all Forward Prirt Delete Sendffecy Addresses Find

[pt====t bocanata

Folders Internet Connection Wizard ! 2

Is?] Cutlook Express -
EI@ Local Folders Internet E-mail Address ,\(
B2 Inbex
@ Cukbios 4
@ Sent Ikems
@ Deleted Items (1)

Your e-mail address is the address other people use to send e-mail meszages to you.

5 @ Drafts
E-mail address: vazamailadreza@zona ba
— For example: someonet@imicrozoft. com
Fro
Sub
Contacks ~ x |
There are no contacts ko display, Click B

on Contacts to create a new contack,

0 messagels), 0 unread

[ < Back ]L Mewt > J[ Cancel ]
3 & Receiving mail...

Slika 11 — Wizard za dodavanje mail naloga

Nakon &to ste uneli Vadu mail adresu kliknite na dugme Next i dobicete prozor kao na slici 12.

¥ Inbox - Qutlook Express

i File Edit Yiew Tools Message Help

¥ . & & .8 « X = W By

Addresses Find

© Create Mail Reply Reply &l Farward Print Delete SendfRecy

I e

R e Internet Connection Wizard b=t -
[g Outlook Express —
E]@ Local Folders E-mail Server Names

: @ Cutbosx

55 Serk Trems

My incoming mail serveriz a | POP3 | ZEMVEL
@ Deleted Items (1) 2 Sl

. 5F Drafts
Incoming mail [POP3, IMAF or HTTF] server:
pop3.zona.ba
Fro
5_"": A SMTP gerver iz the server that is uzed for your outgoing e-mail.
Outgoing mail [SMTP] server:
Contacts ¥ x zmitp.zona b
There are no contacts ko display. Click =

an Contacts o create a new contack,

0 messagers), 0 unread

< Back Newt > Eancel
( aok | Mew> | [ Concel | L &9 Receiving mall...

Slika 12 — Wizard za dodavanje mail naloga — podesavanje dolaznog i odlaznog servera




Unesite podatke kao Sto je prikazano na slici 12. i kliknite na dugme Next nakon Cega Cete
dobiti prozor prikazan na slici 13.

&4 Inbox - Outlook Express

Fil=  Edit Wiew Tools Message Help HF
e ; T e " o

@ . & & .8 2 X =3 WO By,

. Create Mail Reply Reply Al Farimard Frint Diejets SendiRecy Addresses Find

e —— .

Folders Internet Connection Wizard
@ Cutlook Express
=% Local Falders Internet Mail Logon
-AE Inbox
- TE Outhox
o Sent Ttems Type the account name and password your Internet service provider has given pou.
o Deleted Items (1)
S Drafts e onrr e | vasamailadresa |
Fro Paszword: |........... |
Sub Remember password

If paur Intermmet service pravider requires you to use Secure Passward Authentication
Contacts ¥ ® [S5PA] to access your mail account, select the 'Log On Using Secure Password
Authentication [SPA)' check box.

[1 Log on using Secure Pazsword Authentication (5PA]

There are no contacts ta display, Click
on Contacks to create & new conkack.

[ < Back J[ et > ,] [ Carncel ]
0 messagels), 0 unread E & Receiving mail...

Slika 13 — Wizard za dodavanje mail naloga

U polje Account Name unesite username (prvi deo Vase mail adrese ili ¢itavu mail adresu), u
polie Password unesite password i Cekirajte polie Remember password kako vam Outlook
Express ne bi trazio password svaki put kada primate pos$tu. Kliknite na dugme Next, zatim na
dugme Finish i dobicete prozor kao na slici 14. €¢ime je zavrSen prvi deo dodavanja mail naloga.



2.2Dodatna podesavanja odlaznog servera (autentikacija)

¥4 Inbox - Outlook Express

i File Edit  Wiew Tools  Message  Help e#
. & @ .8 X = . W B .
¢ Create Mail Reply Reply all Forward Print Dielete Send/Recy Addresses Find

Internet Accounts

Folders X |
ISE] Otitlosk Express Al | Mail || News | Directo Service | i hdd
=45 Local Folders
@ Inbox Account Type Connection Remove
@ Outbo @Active Diirectony directory service Laocal Area Netwark,
B A Sent Items Bigfoot Internet ... directary service Local Area Network e plaliss
----- @ Deleted Items (1) % pop3.zona.ba mail [default] Ay Available 5k s Dotaut
5B} Drafts CedVeriSion Intemet . directory service Local Area Metwork =
%Who\:\u"here Inter...  directory service Local Arza Network m
Fro
Suljl
L= Set Order...
There are o contacts to display. Click
on Contacts ko create a new conkack,

swarking Cnline 29 Receiving mail...

Slika 14 — Prozor za dodavanje/podesavanje mail naloga

0 message(s), 0 unread

Nakon $to ste dodali mail nalog kako je opisano u prvom delu (2.1) potrebno je da se urade
dodatna podesavanja odlaznog servera kako bi mogli da Saljete postu preko Zona odlaznog mail
servera. Da biste ovo uradili izaberite mail nalog koji ste upravo dodali (pop3.zona.ba) kao §to je
pokazano na slici 14. i kliknite na dugme Properties nakon ¢ega ¢e Vam se otvoriti prozor
prikazan na slici 15.

»4 Inbox - Outlook Express

File Edit %iew Tools Message Help
B . & & e : B .
: Create Mai CESUSNNNEE TR, = pop3.zona.ba Properties Find

General | Servers | Connection | Security || Advanced |

Folders X | '

ISF] Outlook Express

M ail &ccount

Type the name by which you would like to refer to these
servers. For example: "Work' or "Microzoft Mail

Server.
Bemaove

T
1=

=8

=

-

7 Sert Ttems Properties

Deleted Items (1)

Uzer Infarmation

H i 5 Set az Detault
4B} Drafts Mame: ||me i Prezime |
Organizatior: | | l Import... ]
E-mail address: | vazamailadresa@zona ba |
Fro Feply address: | |
1 Include this account when receiving mail or synchronizing SRR

There are no contacts ko display. Click.
on Contacts to create a new contack,

[, aK J[ Cancel ] Apply

& Receiving mail...

Slika 15 — Prozor za podeSavanje/izmenu parametara mail naloga

0 messagels), 0 unread waorking Online




lzaberite tab Servers, Cekirajte My server requires authentication i Kkliknite

Settings nakon ¢ega ¢e Vam se otvoriti prozor prikazan na slici 16.

Folders
7] Outlook Express
= J@ Local Folders
%3 Inbox
; @ Outhos

51 Serkt Ttems
(3 Deleted Items (1)

L $E Drafts

Contacts ¥ x|

There are no contacts to display, Click
on Contacts to create a new contact,

Server Information -

My incoming mail server is a

Laogon Information -
Incoming mail [POP3):

Outgoing mail [SMTF): | (&) Log on wsing
Incoming M ail Server — Agcount name:

I Yasal
e

QOutgoing Mail Server

() Use same settings as my incoming mail server

na dugme

PIX E

| vazamailadresa

Account name; Password:
Password: !...l Femember password
= [ Log on using Secures Password Authentication

Fro [ Log on using Secure Pass [ ok ] [ Cancel ]
Sull
- Outgaing kail Server -

My zerver requires authentication Settings...

ose

[ ok

][ Cancel ][

Apply ]

0 messagels), 0 unread

@ Warking Online

& Receiving mail...

Slika 16 — Prozor za podesavanje login parametara odlaznog servera

Kliknite na Log on using i popunite parametre Account name i Password (prvi deo malil
adrese ili &itava mail adresa i password koji ste dobili prilikom otvaranja mail adrese). Cekirajte
ukoliko ve¢ nije polie Remember password kako vam Outlook ne bi trazio password svaki put
kada Saljete postu. Kliknite dugme Ok i prebacite tab na Advanced. U polje Outgoing mail
(SMTP) unesite broj 465 (broj porta na kome odlazni server ¢eka konekciju od strane Vaseg
mail klijenta) i Cekirajte This server requires a secure connection (SSL) tako da vam
podeSavanja budu ista kao $to je prikazano na slici 17.

¢ Creats Mail

-

Send/Recy

IS;J Cutlook, E>-<press
E‘@ Lacal Folders
A Inbox
} @ Outbo

£ Sent Items
{7 peleted Items (1}

5B} Drafts

There are no contacts to display. Click
on Contacts to create a new contack,

Addresse

Folders x f

Contacts ¥ x|

—

.‘_\\»\

W=

| "= pop3.zona.ba Properties

Rx !

Sel

b Az Sult

Cloze

Server Port Numbers
Outgoing mail (SMTP: 468 | [ Use Defauts |
Thiz server requires a secure connection [S5L)
E-r : 3 ||
Incoming mail [POP3): ! 110 |
[ This server requires a secure connection (S5L]
Server Timeouts
Shat Long 1 minute
Sending
Ne =
[] Break apart messages larger than |50 | KB
Delivery -
[ Leave a copy of messages on server
Co
™ wh [ 0k ] [ Cancel ] [ Apply ]

Mot connected to ‘pop3.zona.ba’

@ Working Online

d a Message...
Tip of the day X

Identities allow multiple
people to use Cutlook
Express without sharing a
commaon inbox,

To create an identity, click
the File menu, click
Identities, and then click
Add New Identity,

Go tomsn®

Identities -

Slika 17 — Dodatno podesavanje parametara mail servera



Nakon §to ste uneli podatke kao $to je prikazano na slici 17. kliknite na dugme Apply, zatim na
dugme OK pa dugme Close Cime je zavrSeno dodavanje/podeSavanje mail naloga koristeci
Outlook Express mail klijent.

Ukoliko niste dobili od Zone mail adresu prilikom prijava/otvaranja naloga za internet ili imate
nekih nejasnoc¢a vezanih za ova podeSavanja mozete se obratiti nasoj Tehnickoj Podrsci na broj

055/420-200.



